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TRADEMARKS
MATLAB is a registered trademark of MathWorks.
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Microsoft and Windows are registered trademarks of Microsoft Corporation.
Smart VacPrep is a trademark of Micromeritics Instrument Corporation.

Copyright

The software described in this manual is furnished under a license agreement and may be used or
copied only in accordance with the terms of the agreement.
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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and
service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their
reliability and durability. However, these materials cannot be totally guaranteed against wear and/or decomposition by
chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization
to return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. Ser-
vice charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our entire
liability in respect to such products, except as an authorized person of MICROMERITICS may otherwise agree
to in writing.

2. If an instrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves,
seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such
items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of
manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including
but not limited to, the implied warranties of merchantability or fitness for use.
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CORPORATE PROFILE
Micromeritics Instrument Corporation is the world’s leading supplier of high-performance systems
to characterize particles, powders and porous materials with a focus on physical properties,
chemical activity, and flow properties. Our technology portfolio includes: pycnometry, adsorption,
dynamic chemisorption, particle size, intrusion porosimetry, powder rheology, and activity testing
of catalysts. The company has R&D and manufacturing sites in the USA, UK, and Spain, and
direct sales and service operations throughout the Americas, Europe, and Asia. Micromeritics
systems are the instruments-of-choice in more than 10,000 laboratories of the world’s most
innovative companies and prestigious government and academic institutions. Our world-class
scientists and responsive support teams enable customer success by applying Micromeritics
technology to the most demanding applications. For more information, please visit
www.Micromeritics.com.
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CONTACT US
Micromeritics Instrument Corporation

4356 Communications Drive
Norcross, GA / USA / 30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696
www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3666
International: Contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com

Micromeritics Application Support
Support@Micromeritics.com
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General Safety

GENERAL SAFETY

Do not modify this instrument without the authorization of a Micromeritics service
personnel.

Use caution in the areas where this symbol is displayed on the instrument — such as
near the heating stations. These surfaces may be hot and could cause serious burns.
Use the gloves supplied in the accessories kit.

Any piece of laboratory equipment can become dangerous to personnel when improperly
operated or poorly maintained. All employees operating and maintaining Micromeritics
instruments should be familiar with its operation and should be thoroughly trained and instructed
on safety.

n Read the operator manual for any special operational instructions for the instrument.
n Know how the instrument functions and understand the operating processes.

n Wear the appropriate personal protective equipment when operating this
instrument — such as eye protection, lab coat, protective gloves, etc.

n When lifting or relocating the instrument, use proper lifting and transporting devices
for heavy instruments. Ensure that sufficient personnel are available to assist in
moving the instrument. The Smart VacPrep weighs approximately 32 kg (70 lb).

n Always pay attention to the safety instructions provided on each label affixed to the
instrument and do not alter or remove the labels. When inspecting the instrument,
ensure that the safety labels have not become worn or damaged.

n The Smart VacPrep has a safety shield. Ensure it is in place when operating the
instrument.

n Proper maintenance is critical to personnel safety and smooth instrument
operation and performance. Instruments require regular maintenance to help
promote safety, provide an optimum end test result, and to prevent costly down
time. Failure to practice proper maintenance procedures can lead to unsafe
conditions and shorten the life of the instrument.

n Improper handling, disposing of, or transporting potentially hazardous materials
can cause serious bodily harm or damage to the instrument. Always refer to the
MSDS when handling hazardous materials. Safe operation and handling of the
instrument, supplies, and accessories is the responsibility of the operator.
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INTENDED USE
The Smart VacPrep degasser is an advanced six-port system that utilizes vacuum to prepare
samples by heating and evacuation. Each of the ports may be operated independently. Samples
may be added or removed from degas ports without disturbing the treatment of other samples
undergoing preparation. Degassing automatically terminates when the samples have completed
all programmed steps.

The instrument is intended to be operated by trained personnel familiar with the
proper operation of the equipment recommended by the manufacturer and as well as
relevant hazards involved and prevention methods. Other than what is described in
this manual, all use is seen as unintended use and can cause a safety hazard.

The instrument is intended to be used as per applicable local and national regulations.

TRAINING
It is the customer's responsibility to ensure that all personnel operating or maintaining the
equipment participate in training and instruction sessions. All personnel operating, inspecting,
servicing, or cleaning this instrument must be properly trained in operation and machine safety
before operating this instrument.

General Safety
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General Safety

ENVIRONMENTALLY FRIENDLY USE PERIOD

Part Name
Hazardous Substances

Lead
(Pb)

Mercury
(Hg)

Cadmium
(Cd)

Hexavalent
Chromium
(Cr (VI))

Polybrominated
biphenyls
(PBB)

Polybrominated
diphenyl ethers

(PBDE)
Cover o o o o o o

Power
Supplies x o o o o o

Printed
Circuit
Boards

x o o o o o

Cables, Con-
nectors &
Transducers

x o o o o o

Hazardous Substances Table

o Hazardous substance is below the specified limits as described in SJ/T11363-2006.
x Hazardous substance is above the specified limits as described in SJ/T11363-2006.

The Environmentally Friendly Use Period (EFUP) for all enclosed products
and their parts are per the symbol shown here unless otherwise marked. Cer-
tain parts may have a different EFUP (for example, battery modules) and are
marked to reflect such. The Environmentally Friendly Use Period is valid only
when the product is operated under the conditions defined in the product
manual.
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ABOUT THIS MANUAL

The following can be found on the Micromeritics web page (www.Micromeritics.com).

n Parts and Accessories
n Error Messages
n Vacuum Pump Guide (PDF)

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear in this manual:

NOTE — Notes contain important information applicable to the topic.

CAUTION—Cautions contain information to help prevent actions that may damage
the analyzer or components.

WARNING—Warnings contain information to help prevent actions that may cause
personal injury.

WARNING - SURFACE MAY BE HOT—Warnings contain information to help
prevent actions that may cause personal injury. This symbol indicates that surfaces
may be hot and may present dangers if touched.

About this Manual
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1 ABOUT THE SMART VACPREP
The degas programmay be started or terminated by using software installed on the computer
attached to the analysis instrument or with buttons on the front panel of the Smart VacPrep. The
Rapid-Startmode on each port allows the operator to attach the sample tube with heating mantle
and immediately start degassing a sample.

The Smart VacPrep is compatible with the Flex, ASAP 2460, and TriStar II Plus.

A. Safety shield (only
one shown)

B. Start/Stop buttons
C. Rapid-Start sample

port select buttons
D. Status indicator lights
E. Heating mantles

1 About the Smart VacPrep
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1 About the Smart VacPrep

Component Description
Ethernet port (not
shown)

Located on the left side panel. Use to connect an Ethernet switch.

Heating Mantles Covers the bottom of the sample tube while degassing is in process.

Power Switch (not
shown)

Located on the back of the unit. Powers the unit on or off.

Rapid-Start Sample
Select buttons

Select the ports to be degassed.

Safety Shield Place the safety shield over the sample tubes while the instrument is
degassing.

Start/Stop buttons Starts or stops the degas process on all ports where the Select indic-
ator is lit.

Status Indicator lights Three lights indicate the current status of the station. The lights flash
when the valves are open.

Green. Indicates the station is idle and not hot. The setpoint
temperature is below 30 ºC and the actual temperature is below
50 ºC.

Red. Indicates when the setpoint temperature is greater than 30 ºC
and heat is being applied to the station.

Yellow. Indicates the station is in use, but not currently being heated.
The heating mantle may still be above 50 ºC.

Smart VacPrep Components
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SPECIFICATIONS FOR THE SMART VACPREP

Backfill Options Automatic

Capacity 6 ports

Degas Method Heat and vacuum

Evacuation Period Determined by selected elapsed time after achievement of selec-
ted low pressure target

Evacuation Rate Selectable evacuation rate from 1.0 to 50.0 mmHg/s

Hold Time Zero to 999 minutes in one minute increments

Vacuum Control Servo-controlled rates to minimize or eliminate sample elutriation

Heating of Samples Heating mantles

Ramp Rate Selectable from 0.1 to 10 °C per minute

Heating

Accuracy Deviation less than ±10 °C at the sensing thermocouple embedded
in the heating mantle

Control One ramp during evacuation phase, five additional ramps during
subsequent phases

Range 40 to 450 °C in one degree increments

Temperature

Nitrogen, argon, or any other pure gas that does not adsorb at room temperature

Gases

Specifications for the Smart VacPrep
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1 About the Smart VacPrep

Temperature 10 to 35 ºC operating; 0 to 50 ºC non-operating
Maximum rate of change of 2 °C per hour

Humidity 20 to 80% relative, non-condensing

Indoor or Outdoor Use
Indoor only (not suitable for wet locations)
Altitude: 2000 mmax
Pollution degree of the intended environment: 2

Degree of Ingress
Protection IPX0

Environment

Voltage 100/120/230/240 VAC (acceptable mains supply voltage
fluctuations: ± 10% of rating)

Power 750 VA

Frequency 50/60 Hz

Overvoltage Category II

Electrical

Height 69 cm (27 in.)

Width 53 cm (21 in.)

Depth 43 cm (17 in.)

Weight 32 kg (71 lbs)

Physical
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Operating System Windows 10 or higher operating system is required.

Desktop Installation
Required

The application should not be installed on a network drive with
shared access.

Multiple users cannot operate the application at the same time.

Ensure the "Sleep" setting on the desktop is set to
"Never" to avoid interruption while running an analysis.
If this occurs, the application loses network
connectivity with the instrument and a communications
error will be reported. A restart of the Windows
application may be required if automatic reconnection
is not successful.

10 Base T or 100 Base T
Ethernet Port

If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet-based unit is connected to
the same computer, an Ethernet switch will also be required.

Read/Write Permissions All application users will need Read/Write permission to all
directories and subdirectories where the application is installed.

Drives USB port

Computer Requirements

Due to continuous improvements, specifications are subject to change without notice.

Specifications for the Smart VacPrep

Smart VacPrep Operator Manual
067-42801-01 (Rev A) — June 2022 1 - 5



1 About the Smart VacPrep

CHECK SEAL AND TRANSEAL
Parts and accessories are located on the Micromeritics web page.

Check Seas and TranSeals are available and can be used to transfer air-sensitive samples from
the Smart VacPrep to the analyzer's port without atmospheric contamination. They are designed
for use with the 1/2 in. and 12 mm sample tubes. Instructions for using the Check Seal or TranSeal
are included with the ordered part.

The Smart VacPrep is shipped from the factory with Check Seal openers installed inside each
sample tube port.

Sample Tube Size Opener Removal Required Assembly Available
1/4 in. Yes No

3/8 in. Yes No

1/2 in. No Yes

9 mm Yes No

12 mm No Yes

CheckSeal and TranSeal Information
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2 ABOUT THE SOFTWARE

The Smart VacPrep software is installed as a part of the analyzer installation or it can be installed
as a standalone unit. During installation, an IP address will be assigned to the unit allowing the
unit to connect automatically during startup. Up to three additional degasser units can be installed
when running Micromeritics analyzer analysis software.

COMMON FIELDS AND BUTTONS
The fields and buttons in the following table are located in multiple windows throughout the
analyzer application and have the same description or function. Fields and button descriptions not
listed in this table are found in tables in their respective sections. All entry fields will accept
information when using a bar code reader.

Selections Description
Add Log Entry Use to enter information that will display in the sample log report that

cannot be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Browse Searches for a file.

Cancel Discards any changes or cancels the current process.

Clear Clears all fields.

Close Closes the active window and displays a prompt to either accept or
reject changes.

OK Saves and closes the active window.

Save Saves changes.

Start Starts the operation or process.

Common Fields and Buttons

2 About the Software
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2 About the Software

EXPORT FILES
File > Export
Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or a file. Data can be exported as a .PDF, .TXT, .XML, or .XLS file format. The
type of data to include or exclude can be selected during the export process. The data can be
imported into other applications that read these file formats when exported to a file.

1. Select a .DEG file to be exported.
2. Click Export and select export preferences.
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INSTRUMENT STATUS

SHOW DASHBOARD

Prep [n] > Show Dashboard
The dashboard displays the following:

n Number of days until roughing pump maintenance is due
n Manifold outgas rate

Data for the dashboard comes from the logged diagnostic data. The dashboard is automatically
kept current as the relevant diagnostic data items are updated. The gauges will be updated even if
the dashboard window is not open.

Red numbers on the dashboard require attention. To reset the dashboard numbers,
right-click on the dashboard setting, then click Reset.

Selections Description
Days until roughing-
pump service is due

Annual maintenance is recommended. The number of days until the
anniversary of the last pump maintenance is shown. The displayed
value is updated at least once per day and when the maintenance
time is reset. When the displayed value is 30 or less, the value is
displayed in red. Red negative numbers display if maintenance is
past due.

Dashboard Gauges

Instrument Status
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2 About the Software

Selections Description
Manifold outgas rate Provides the qualitative indication of the outgas rate in the dosing

manifold. LED images constitute a bidirectional bar graph of the
outgas rate.

The gauge is updated after each outgas rate measurement.

n Three green LEDs are lit if outgas rate is below 30% of outgas rate
limit.

n At 30%, the left LED turns off.
n At 60%, the center LED turns off.
n At 90%, three green LED lights turn off and the center yellow

LED is turned on.
n At 110% and above, only the red LED is lit and attention is

required.

Smart VacPrep fields and buttons not listed in this table; see Common Fields
and Buttons on page 2 - 1.

Dashboard Gauges (continued)

2 - 4 Smart VacPrep Operator Manual
067-42801-01 (Rev A) — June 2022



SHOW LOG

Prep [n] > Show Log
Use to display a log of recent analyses, calibrations, or messages.

Field Description
Analysis /
Calibration /
Message

Select the logs to display.

Smart VacPrep fields and buttons not listed in this table; see Common Fields
and Buttons on page 2 - 1.

Log Fields

Show Log
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2 About the Software

SHOW SCHEMATIC

Prep [n] > Show Schematic
Use to display an analyzer schematic. To operate the valves and heating mantles from this
window, manual control must be enabled (Prep [n] > Enable Manual Control).

A. Vacuum reading
B. Pressure reading
C. Servo
D. Heating mantle controls

Selections Description
Open Valve.Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve.

Servo Valve. Closed.

Servo Valve.Open.

Sample Tube. Cannot be manually controlled.

Schematic Component Icons
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Schematic
Components

Description

1-6 Sample port valves

7, 8, 9 Vacuum and backfill valves

Heating mantle
controls

Sets the ramp rate and target temperature

Schematic Components

Schematic Shortcut Menus

Each manually controlled schematic component has a shortcut menu displaying the operations
available for that particular component. To access the shortcut menu, hover the mouse pointer
over the component and right-click.

Schematic Shortcut
Icon

Available Options:

Valve options Close. Closes the selected valve.

Open. Opens the selected valve.

Set. Use to set the servo valve target pressure and dose or
evacuate.

Temperature control
options

Disable. Select to disable the temperature control options for the
selected port.

Set. Select to set the following:
n Enable or disable temperature control
n Control sample temperature
n Control furnace temperature
n Cool the sample to less than 50 °C
n Set heater power percent

Schematic Shortcuts

Show Schematic
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2 About the Software

SHOW STATUS

Prep [n] > Show Status

The status window allows the monitoring of degas operations for a manual degas operation.

Selections Description
Check Click to check the outgassing rate of the samples on the selected

port. The following process occurs:

n The current degassing step is suspended.
n The vacuum valves are closed and the vacuum level on the selec-

ted ports is monitored.
n The Status window indicates that the degassing operation is being

checked and displays the outgassing rate as it becomes available.

During the degas check, the Check button changes to Continue.
When Continue is clicked, the valves open and the degassing
operation resumes.

If the outgassing rate indicated that the sample has been freed of
contaminants (minimal pressure increases), click Skip to advance to
the next state of the degassing operation. For example, if degassing
is checked after the setpoint is attained, Skip advances to the
ramping stage.

Sample The name of the sample file.

Skip Skips the current degas operation.

Status Indicates the current status of the degas.

Smart VacPrep fields and buttons not listed in this table; see Common Fields
and Buttons on page 2 - 1.

Status

2 - 8 Smart VacPrep Operator Manual
067-42801-01 (Rev A) — June 2022



KEYBOARD SHORTCUTS
Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the
menu command. For example, to access the Filemenu, press Alt + F, then press the underlined
letter on the submenu (such as pressing Alt + F) then pressingO to open the File Selector).

If the underscore does not display beneath the letter on the menu or window, press
the Alt key on the keyboard.

Selections Description
Alt + F Opens the Filemenu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to
save changes displays.

Alt + H Opens the Helpmenu.

Alt + I Opens theOptionsmenu.

Alt + W Opens theWindowmenu.

Ctrl + O Opens the File Selector window.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Opens the File Selector window.

F6 Cascades open windows.

F7 Tiles all open application windows.

Shift + F2 Opens the File List window.

Keyboard Shortcuts

Keyboard Shortcuts
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2 About the Software

LIBRARIES
Options > Manage Libraries

This feature is not available when using Restricted option presentation.

The library provides an easy way to locate and open specific analyzer files. Libraries are located
within the File Selector window and can be viewed only within the application.

The library gathers sample and parameter files stored in multiple locations, such as folders on a C:
drive, a network location, a connected external hard drive, or a connected USB flash drive, and
provides access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items, such as saved searches and search
connectors, cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original
file storage location. However, when deleting files or folders from within a library, they are deleted
from their original file storage location. Deleted files and folders can be recovered from the
Recycle Bin located on the Windows desktop.
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LIST FILES
File > List
Provides the option to create a list of sample file information—such as file name, date, time the
file was created or last edited, file identification, and file status.

Select one or more files from the file selector, click List, then provide the file destination.

Example of
File List

MENU STRUCTURE
All program functions use standard Windows menu functionality. The title bar contains a Prep [n].
If multiple Smart VacPreps are installed, ensure the appropriate unit is selected before continuing.

Option Description
File Use to add or remove Smart VacPreps and manage files.

Prep [n] Use to degas, perform calibrations, diagnostics, and other degasser oper-
ations.

Options Use to edit units and manage the library.

Window Use to manage open windows and display a list of open windows. A
checkmark appears to the left of the active window.

Help Provides access to the embedded operator manual, the Micromeritics web
page (www.Micromeritics.com), and information about the application.

Main Menu Bar Options

List Files

Smart VacPrep Operator Manual
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2 About the Software

SMART VACPREP CONFIGURATION
Prep [n] > Configuration

Displays the Smart VacPrep configuration and software versions.

Selections Description
Board ID [button] Click to display the board ID. This button is disabled if the instrument

is busy.
Change IP [button] Click to display the Unit IP Setup window. Use to change the IP

address and subnet mask assigned during installation. Do not edit
these fields unless instructed by a Micromeritics Service
Representative.

Remove 067 Unit
[button]

Click to remove the selected Smart VacPrep unit.

Smart VacPrep fields and buttons not listed in this table; see Common Fields
and Buttons on page 2 - 1.

Unit Configuration
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ADD OR REMOVE A SMART VACPREP

A Smart VacPrep unit must be removed from one application before it can be added to another
application if they are running on the same subnet.

Add a Smart VacPrep

File > Add Smart VacPrep

1. When prompted, enter the serial number of the unit being added. Duplicate serial numbers
are not allowed.

2. Click Add. Initialization begins.

Remove a Smart VacPrep

File > Remove Smart VacPrep

1. Select the serial number to remove.
2. Click Remove.

Add or Remove a Smart VacPrep
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2 About the Software

UNIT SELECTION

Options > Units
Use to specify how data should appear on the application windows and reports. This menu option
is not available if using Restricted option presentation in a standard installation environment.

SOFTWARE SETUP

If the computer is to be connected to a network, a second Ethernet port on the
computer must be used for that purpose.

The Setup program is located on the installation media and is used to reinstall the software and
make analyzer changes— such as adding, moving, or removing a unit, etc.

If the IP address needs to be changed on the computer connected to the analyzer,
refer to the computer's operating systemmanual or the internet for instructions. The
IP address for the computer and the IP address specified in the setup programmust
match. The IP address must be 192.168.77.100.
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SOFTWARE UNINSTALL
The software can be uninstalled in two ways. Either method removes only the files required to run
the software, not the analysis files.

n Click the Windows Start icon. Scroll to the Micromeritics entry. Select the Uninstall [analyzer]
option, then follow the prompts.

n Locate the uninstall.exe file in C:\Program Files (x86)\Micromeritics\[analyzer name] (or
wherever the application was installed). Double-click the uninstall.exe file, then follow the
screen prompts.

SOFTWARE UPDATES

A User Account Control in the Windows operating systemmust be enabled to ensure
all components of the Micromeritics application are correctly installed. If UAC is not
enabled, right-click the setup.exe installer file and select Run as administrator.

The most current version of the instrument software can be found on the Micromeritics web page
(www.Micromeritics.com).

When performing a software update, existing data files are not overwritten.

Insert the setup media into the media drive. The setup program starts automatically. If the
program does not start automatically, navigate to the installation media drive, locate and double-
click the setup.exe file.

Software Uninstall
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3 OPERATE THE SMART VACPREP

START DEGAS
Prep [n] > Start Degas
Parts and accessories are located on the Micromeritics web page.

This option allows the degassing of up to six samples simultaneously. A sample can be added to
any idle port and a degas operation started. When adding a sample, the degas operation in
progress will be suspended until the sample reaches the target pressure, then degassing on all
ports will resume. If other samples are still in the initial evacuation phase, the new samples will
wait until the fast evacuation is started. Samples can be removed from any of the six ports without
disturbing the degas operations already in process. Starting several samples as a batch allows
them to perform the initial evacuation at the same time.

Degas conditions remain the same from degas to degas unless the Degas Conditions file is
changed or replaced by the operator. A manual evacuation can be performed on any idle degas
port. The six ports are represented by row numbers. Ports that are busy are grayed out and
disabled.

1. Open a .SMP or .DEG file for each Smart VacPrep port to be used. If using the Check Seal,
see the instructions included with the Check Seal [part number 350-42802-00].

2. Load the sample into the sample tube. If using a Check Seal or TranSeal on a 1/2 in. or
12 mm sample tube, insert it into the sample tube.

3. Load the sample tube on the Smart VacPrep sample port.
4. Attach the heating mantle using the metal clip. If a straight wall tube is used, heating

mantles with elastic cords are available.
5. Install the safety shield.
6. Click Start on the Start Degas window to begin the degas process for the selected Smart

VacPrep ports.
7. Click Start to begin the degas process for the selected Smart VacPrep ports.
8. Allow the samples to cool before transferring them to the analysis ports to start the analysis.

3 Operate the Smart VacPrep
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3 Operate the Smart VacPrep

Degas ports can also be canceled using buttons on the Smart VacPrep unit. Press
Select on the unit to select the port, then press the Cancel button.

EVACUATE PORTS
Prep [n] > Evacuate Ports

Selections Description
Evacuation Options
[group box]

Evacuation rate. The maximum rate of change of pressure when
evacuating the sample tube.

Unrestricted evac. from. Pressure at which the unrestricted
evacuation is to begin.

Vacuum level. Evacuation time starts when the vacuum level is
reached.

Evacuate Port[s]
[group box]

Select the ports to evacuate.

Smart VacPrep fields and buttons not listed in this table; see Common Fields
and Buttons on page 2 - 1.

Evacuate Ports
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BACKFILL PORTS
Prep [n] > Backfill Ports
Use to backfill ports with gas.

1. Enter the backfill pressure in the Backfill pressure field.
2. Select the ports to be backfilled.
3. Click Start to start the process or Cancel to stop the process.

Backfill Ports
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3 Operate the Smart VacPrep

QUICKSTART DEGAS CONDITIONS
Prep [n] > QuickStart Degas Conditions
Use to enter commonly used degas conditions for each Smart VacPrep port without the need for a
sample file. Degassing can then be started using the front panel buttons on the Smart VacPrep
unit.

This option provides three ways to load information intoQuickStart Degas Conditions:

n Load degas conditions from an existing degas conditions file.
n Copy conditions from another Smart VacPrep unit and port.
n Enter degas conditions manually.

Degas conditions can be copied into sample files after degassing for record keeping.

When using theQuickStartmenu option, the degas process is started using the Select button and
Start buttons for each port on the Smart VacPrep unit.

QuickStart degas conditions are remembered for the next button operation.

1. Click Edit for the port to be configured. The six ports are represented by row numbers.
Ports that are busy are grayed out and disabled.
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2. Enter degas conditions using one of the following methods:
n To select degas conditions from a Degas Conditions file, click the drop-down arrow to the

right of the Degas Conditions field. If the file is not shown, select Browse, locate the file,
then click Load.

n To copy QuickStart Degas Conditions from another Smart VacPrep, select the unit and
port number to the right of the Copy QuickStart Degas Conditions from Smart VacPrep
Unit field.

n To enter degas conditions manually, complete the fields on the window. See the Degas
Conditions section of the analyzer operator manual

3. Click Save. Repeat these steps for each port to be configured. If multiple ports will have the
same degas conditions parameters, click Edit on the port and use the Copy QuickStart
Degas Conditions from Smart VacPrep Unit [n] Port [n] field to load the settings from the first
port.

4. Repeat these steps for each applicable unit and port.
5. If using the Check Seal, see the instructions included with the Check Seal [part number

350-42802-00]. For 1/4 in., 3/8 in., and 9 mm sample tubes, the CheckSeal opener must be
removed in order to install the correct size sample tube.

6. Load the sample into the sample tube. If using a Check Seal or TranSeal, insert it into the
sample tube.

7. Load the sample tube on the Smart VacPrep sample port.
8. Attach the heating mantle using the metal clip. If a straight wall tube is used, heating

mantles with elastic cords are available.
9. Install the safety shield.
10. Press the Select button for the port to be degassed. A blue LED is lit.
11. Press the Start button on the Smart VacPrep panel to start the degas process for all ports

that have a blue LED lit.
12. When degassing is complete and the sample has cooled, the sample can be transferred to

an analysis port.

QuickStart Degas Conditions
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3 Operate the Smart VacPrep

LOAD QUICKSTART DEGAS CONDITIONS INTO A SAMPLE FILE

QuickStart Degas Conditions can be copied into a sample file. See the Degas Conditions section
of the analyzer operator manual.

Selections Description
Copy QuickStart
degas conditions
from Smart VacPrep
Unit [drop-down box]

Use to copy the degas conditions settings from the selected
Smart VacPrep unit and port.

Degas conditions
[drop-down box]

Use to browse for a .DEG file that contains degas condition para-
meters to be used in the analysis.

Heating Phase [table] This option is applicable when degassing with a Smart VacPrep.

Enter up to five stages of degas conditions.

Temperature. Temperature at which the sample is to be held while
degassing.

Time. How long the sample is to be held at the specified temperature
before beginning to cool down.

Temperature Ramp Rate. The rate at which the temperature will
change while advancing to the hold temperature.

Smart VacPrep
Evacuation
[group box]

Backfill sample tube. Indicate if the sample tube should be backfilled
automatically or wait for operator response.

Evacuation rate. Rate used for evacuation.

Evacuation time. Length of time for preliminary evacuation before
proceeding with the Heating Phase temperature schedule. The timer
starts when the vacuum level is reached.

Hold pressure. Pressure at which heating will stop and hold the
sample temperature approximately constant until the pressure falls
below the Hold pressure. This prevents damage to the sample
structure due to 'steaming' and /or elutriation due to excessive
escaping gas velocity.

Target temperature. Targeted temperature for evacuation.

Temperature ramp rate. Rate at which the temperature is to change
when advancing to the target pressure.

Degas Conditions
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Selections Description
Unrestricted evac. from. Pressure at which the unrestricted
evacuation is to begin.

Vacuum level. Evacuation time starts when the vacuum level is
reached.

Smart VacPrep fields and buttons not listed in this table; see Common Fields
and Buttons on page 2 - 1.

Degas Conditions (continued)

Load QuickStart Degas Conditions into a Sample File
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4 CALIBRATION
Prep [n] > Calibration
Various calibration procedures and service tests are included in the operating program. These
procedures and tests are designed to provide a Service Representative with instrument readouts,
as well as to assist in troubleshooting potential problems.

PRESSURE OFFSET

Prep [n] > Calibration > Pressure Offset

Use to perform system calibration. This option evacuates the system and zeros the pressure
transducer.

Disabled calibration options can be accessed only with the assistance of an authorized
Micromeritics Service Representative.

Click Start to begin the process.

4 Calibration
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4 Calibration

SERVO VALVE
Prep [n] > Calibration > Servo Valve

Use to calibrate the servo valve to the manifold pressure transducer. The servo valve should
always be recalibrated after a pressure calibration has been performed. The pressure transducer
should be calibrated before starting this calibration procedure.

Click Start. The window closes when the calibration is complete. Click Cancel to stop the
calibration process.

4 - 2 Smart VacPrep Operator Manual
067-42801-01 (Rev A) — June 2022



5 DIAGNOSTICS
Diagnostics should only be performed by qualified service personnel.

DIAGNOSTIC TEST REPORT
Prep [n] > Diagnostics > Diagnostic Test Report
Displays previously run diagnostic service tests. Separate directories store tests run once, daily,
weekly, and monthly. Diagnostic test report files have a .SVT file extension and are stored in the
...\Service directory.

5 Diagnostics
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6 MAINTENANCE

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.Micromeritics.com).
n Error Messages document (PDF)
n Parts and Accessories
n Vacuum Pump Guide (PDF)

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the MSDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

Do not modify this instrument without the authorization of a Micromeritics service per-
sonnel.

When lifting or relocating the instrument, use proper lifting and transporting devices
for heavy instruments. Ensure that sufficient personnel are available to assist in
moving the instrument. The Smart VacPrep weighs approximately 32 kg (70 lb).

Use of a power cord or power supply not provided with the instrument could cause
personal injury or damage to the equipment. If a replacement is needed, contact your
Micromeritics Service Representative. Detachable power supply cords with an
inadequate rating could cause significant instrument damage or physical harm.

Do not add anything between the power cord and the power source that would
compromise the earth ground.

Do not remove or disable the grounding prong on the instrument power cord.

If the equipment needs to be relocated, check with your Micromeritics service
representative. The equipment must be positioned such that the mains supply is not
obstructed and is easily accessible to disconnect the equipment from the AC main
power supply.

6 Maintenance
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6 Maintenance

Prior to moving the instrument, disconnect and remove all glassware from the
instrument. Ensure all gas shut-off valves on the gas cylinder have been closed and
gas lines disconnected from the instrument. Contact your Micromeritics Service
Representative.

SAFE SERVICING

Do not modify this instrument without the authorization of a Micromeritics service per-
sonnel.

To ensure safe servicing and continued safety of the instrument after servicing, service personnel
should be aware of the following risks:

Product specific risks that may affect service personnel:
n Electrical. Servicing or repair could require opening the outer panels and exposing ener-

gized electrical components.
n Heating stations. Ensure the heating stations are cool and sample tubes have been

removed from all stations. Heating stations can be very hot. Allow the heating stations to
cool prior to servicing.

Use caution in the areas where this symbol is displayed on the instrument — such as
near the heating stations. These surfaces may be hot and could cause serious burns.
Use the gloves supplied in the accessories kit.

Protective measures for these risks:
n Electrical. The majority of electrical components operate at low voltage (24V or less) and

pose low risk when energized. Maintenance, troubleshooting, and repairs should be per-
formed with the instrument de-energized whenever possible, in accordance with standard
electrical safety guidelines.

n Fuses. Use of improperly rated fuses could cause damage to the equipment.
n Sample tubes must be removed prior to repair.
n Power off and unplug the degasser from the power outlet prior to servicing.

Verification of the safe state of the instrument after repair:
n Sample tubes must be removed to prevent accidental breakage.
n Gas lines connected and pressurized to normal operating pressure with no leaks.
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PARTS AND ACCESSORIES
Parts and accessories are located on the Micromeritics web page.

CLEAN THE INSTRUMENT
The exterior casing of the instrument may be cleaned using a clean, lint-free cloth dampened with
isopropyl alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type
of abrasive cleaner. It is not necessary to remove knobs, screws, etc. while cleaning.

Do not allow liquid to penetrate the casing of the instrument. Doing so could result in
damage to the unit.

ENABLE MANUAL CONTROL
Prep [n] > Enable Manual Control
Use to enable the manual control of certain valves and heating mantles. When this option is
enabled, a checkmark appears to the left of Enable Manual Control on the drop-down menu.

If the schematic is not immediately visible, go to Prep [n] > Show Schematic.

OIL-BASED VACUUM PUMP
The Vacuum Pump Guide can be found on the Micromeritics web page (www.Micromeritics.com).

POWER

The Smart VacPrep is designed to operate with line voltage of 100/120/230/240VAC ±10, 50/60
Hz through a standard wall receptacle. Noise-free power of the correct voltage and frequency,
with a safety earth ground, should be available through a standard wall receptacle. There should
be a minimum 15A rated breaker @ 100/120 VAC and a minimum 7.5A@ 240 VAC.

The analyzer and peripheral devicesmust be installed on their own dedicated power
line. Other devices— such as motors, generators, or ovens— should not be placed
on the same power line.

Replacement power supply cords must be rated for the specifications stated above.

Parts And Accessories
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6 Maintenance

PREVENTIVE MAINTENANCE

Perform the following preventive maintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventive maintenance procedures and
calibration be performed by a Micromeritics Service Representative every 12 months.

Maintenance Required Frequency
Instrument exterior Clean a needed or every 6 months.

Port filters and
O-rings

Replace every 3 to 6 months.

Port gasket Replace every 3 to 6 months (depending on the types of
analyses that were run).

Sample tube
O-ring

Replace as required or every 3 to 6 months.

Vacuum pump Reference the vacuum pump guide.
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GUIDELINES FOR CONNECTING GASES

These instructions refer to the installation of a gas line, regulator, and gas cylinder for
each type of gas used. Expansion kits or other accessories may be used in the lab. If
so, special consideration should be given to these configurations when installing the
gas lines.

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the MSDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

n Place gas cylinders within 6 feet (2 m) of the gas inlets of the analyzer. Place the cylinders
close enough to allow for proper connection at the analyzer inlet.

Using gas line extenders on gas cylinders located in remote areas may degrade gas quality
and reduce pressure. Gas lines are typically five to six feet long.
Long gas lines, such as those used with gas cylinders placed in remote areas, must be
evacuated for an extended period of time to remove ambient gases. When possible, avoid
placing gas cylinders in remote locations. It is always best to have gas cylinders located near
the analyzer.

n Use a retaining strap (or other appropriate tether) to secure the gas cylinder.
n Always use the gas lines provided with the analyzer. It is very important that proper gas lines

are used with the analyzer.

o Do not use polymer tubing for the gas line.
o Do not use flexible gas lines. Some flexible lines may appear to be appropriate, such as
those with a herringbone covering, but the line may be coated internally with a polymer.

n Carefully route the gas lines from the cylinder to the analyzer avoiding overlapping or
entangling gas lines. This will help avoid confusion when maintenance is required.

n Label the gas line at the analyzer inlet for proper identification and maintenance.
n Replace gas cylinders before gas is depleted. It is best to replace a gas cylinder when the pres-

sure reads approximately 500 psi (3500 kPa) on the high-pressure gauge. Contaminants
absorbed to the walls of the cylinder will desorb as the pressure decreases.

n Ensure the gas cylinder is closed before connecting to the analyzer.

Guidelines for Connecting Gases
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6 Maintenance

REPLACE A GAS CYLINDER

A power failure or loss of cryogen can result in dangerous pressures in the sample
chamber. When using toxic or flammable gases, additional venting of the cabinet may
be required.

A. Gas tubing to instrument
B. Gas regulator shut-off valve
C. Low pressure gauge
D. High pressure gauge
E. Gas cylinder shut-off valve
F. Regulator connecter nut
G. Regulator control knob
H. Brass reducer fitting

Disconnect a Depleted Gas Cylinder

1. Close the regulator shut-off valve and gas cylinder shut-off valve by turning the knobs clock-
wise.

2. Disconnect the gas line from the regulator. Gas will be vented from the line. It is not neces-
sary to disconnect the gas line from the analyzer inlet if the cylinder will be replaced imme-
diately with one of the same type.

3. Open the gas regulator shut-off valve by turning the knob counterclockwise. Gas will be ven-
ted from the regulator.

4. Turn the regulator control knob clockwise to open and vent any remaining gas. Both gauges
should read at or near zero. If not, make sure the gas regulator shut-off valve is open.

5. Close the regulator by turning the control knob counter-clockwise.
6. Use an appropriate wrench to loosen the nut at the regulator connector nut then remove the

regulator from the cylinder.
7. Replace the protective cap on the depleted cylinder. Disconnect the retaining strap and

move the cylinder to an appropriate location.
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Connect a Gas Cylinder

Analyzer Gauge should indicate
Smart VacPrep 10 - 15 psig (69 - 103 kPag)

Regulator Pressure Settings

Exceeding the maximum recommended air pressure could cause personal injury or
damage the instrument.

Replace a Gas Cylinder
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6 Maintenance

SAMPLE TUBE INSTALLATION

If using an HPVA instrument, see Sample Tube for HPVA on page 6 - 10 for instruc-
tions on converting the Smart VacPrep to accommodate the HPVA sample tubes.

1. While holding the degas port plug, turn the connector nut counter-clockwise to loosen.
Remove both the plug and the nut.

A. Port fitting
B. O-ring
C. Ferrule
D. Connector nut

Port plug

2. If using a rubber stopper, remove it from the sample tube. If using a Check Seal or
TranSeal, do not remove them from the sample tube.

3. Place the port connector nut, ferrule, and O-ring onto the sample tube. If using the Check
Seal, see the instructions included with the Check Seal [part number 350-42802-00].

4. To attach the sample tube set to the degas port fitting, push the sample tube in to a full stop.
5. Secure the sample tube in place by sliding the connector nut, ferrule, and O-ring up onto the

degas port fitting and turning the connector nut clockwise. Tighten the nut securely by hand.
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6. If available, place a heating mantle over the sample tube and secure the mantle in place
with a mantle clip if a heating mantle is available.

A. Power plug
B. Thermocouple plug
C. Heating mantle
D. Mantle clip

7. Insert the heating mantle thermocouple plug into the thermocouple connector.
8. Insert the heating mantle power plug into the power connector and twist the power plug to

lock securely.
9. After installing the sample tubes, install the safety shield around the sample tubes and heat-

ing mantles to minimize the risk of receiving a burn by touching hot components.

Sample Tube Installation
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6 Maintenance

SAMPLE TUBE FOR HPVA
When using the Smart VacPrep attached to an HPVA instrument, the sample port fittings must be
changed to accommodate the HPVA sample tubes.

REMOVE THE SMART VACPREP SAMPLE PORT FITTING

1. Use a 3/4 in. open-end wrench to turn the Smart VacPrep degas port connector nut counter-
clockwise. Remove the Smart VacPrep port adapter and store for future use.

2. Remove the two plastic end protective covers from the VCO to ASAP adapter [part number:
P02-25874-00].
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3. Place a Seal Frit in the long end of the VCO adapter.

4. Insert the long end of the Fitting VCO adapter into the Smart VacPrep degas port. Hand
tighten the connector nut by turning the adapter clockwise. Tighten again with a 3/4 in.
wrench. Do not overtighten.

ATTACH AN HPVA SAMPLE TUBE TO THE SMART VACPREP

Refer to the HPVA Operator Manual [part number P02-42806-00] for detailed instructions on
attaching the HPVA sample tube to the Smart VacPrep.

SMART VACPREP FUSE
Although the power entrance appears to need fuses, they have been superseded by the circuit
breaker. Fuses are therefore not necessary.

Attach an HPVA Sample Tube to the Smart VacPrep
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7 DATA LOGGING
The Smart VacPrep has the added capability to collect real time transient data (pressure, vacuum
level, time, and temperatures) during sample degas when connected to the Flex analyzer or
ASAP 2020 analyzer.

This document provides:

n installation instructions for the PuTTY client and outlines how to access and use the data file,
and

n installation instructions for Python components and outlines how the captured data can be
handled using Python scripts.

INSTALL THE PUTTY CLIENT
PuTTY is an open source SSH and telnet client that can be used to access the transient data
output by the Flex or ASAP 2020 analyzer. No additional Micromeritics application is required.
The PuTTY.exe file runs directly from a desktop shortcut. Download the PuTTY application using
the following URL (only save the putty.exe file):

http://www.chiark.greenend.org.uk/~sgtatham/putty/download.html

To connect to the analyzer:

1. In the Flex or ASAP 2020 application, go to Unit [n] > Unit Configuration and make a note
of the analyzer IP address.

2. In the PuTTY Configuration window:

7 Data Logging
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7 Data Logging

a. Enter the analyzer IP address (from Step 1) into the PuTTY application.
b. Enter 54000 (for Flex) or 54101 (for ASAP 2020) in the Port field.
c. Select Raw as the connection type.

3. To save the settings (optional):

a. In the Category box, select Session > Logging.
b. In the Session logging group box, select All session output.
c. In the Log file name group box, click Browse to select the destination and enter a .txt

file name. It may be helpful to name this file the same as the sample file to be analyzed.
4. ClickOpen to start collecting the data.

The PuTTY application can be started before the analyzer starts collecting data— it
will be waiting until data output from the analyzer begins.
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ACCESS THE DATA LOG FILE
The text file created in the previous section (Step 3c) contains the transient data and can be
accessed using any means that accepts tab separated value such as Notepad, Microsoft Excel (or
other spreadsheet software), or programming languages that read .txt or .xls files such as
MATLAB, Octave, and Python. MATLAB has the xlsread() function and Octave has the textread()
function.

DATA FILE COLUMN DESCRIPTIONS
When the data file is viewed in a spreadsheet program, the following columns display:

A. 'manifold pressure (Torr)';
B. 'manifold vacuum (Torr)';
C. 'time (ms)';
D. 'port 1 temperature (C)';
E. 'port 2 temperature (C)';
F. 'port 3 temperature (C)';
G. 'port 4 temperature (C)';
H. 'port 5 temperature (C)';
I. 'port 6 temperature (C)';

Data File Column Descriptions

Smart VacPrep Operator Manual
067-42801-01 (Rev A) — June 2022 7 - 3



7 Data Logging

INSTALL PYTHON COMPONENTS
To operate Python to view real time data, three components should be installed in the following
order:

1. Install PYTHON
n Download URL: https://www.python.org/downloads/
n Download Python version 3.2 or later

Depending on the computer operating system, download file versions may vary, however, the
.msi file should be compatible with computers that operate the Flex or ASAP analyzer.

2. Install NumPY (for numerical functions)
n Download URL: http://sourceforge.net/projects/numpy/files/NumPy/1.6.2/
n Download file: numpy-1.6.2-win32-superpack-python3.2.exe

NumPY contains numerous numerical functions and libraries needed to properly handle the
transient data extracted from the .txt file collected during an analysis. NumPY version 1.6.2
should be download to be compatible with the installed version of Python.

3. Install MatPlotLIB (for graphical display of the data)
n Download URL: http://www.lfd.uci.edu/~gohlke/pythonlibs/#matplotlib
n Download file: matplotlib-1.2.1rc1.win32-py3.2.exe

MatPlotLIB version 1.2.1 is compatible with NumPY from Step 2.
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SAMPLE PYTHON CODE
The following code can be used to produce a plot of pressure versus time. This is the most basic
code needed to see transient data, but the flexibility exists to script a more detailed file allowing for
flexibility such as comparing temperature between ports, generating a separate figure for each
port, etc.

import numpy as np
import matplotlib.pyplot as plt

myFile = 'carbon.txt'
data = np.genfromtxt(myFile, skip_header=2, skip_footer = 1)

# Time (minutes)
x=data[:,2]
x = x/1000/60

# Pressure (Torr)
y=data[:,0]

plt.plot(x,y,'ko')
plt.ylabel('Pressure (Torr)')
plt.xlabel('time (minutes)')
plt.show()

SAMPLE CODE EXPLANATION
import numpy as np
import matplotlib.pyplot as plt

Import is needed to load the modules containing functions to be used— in this case, numerical
and plotting functions. Coding is easier if abbreviations such as np and plt are used.

myFile = 'carbon.txt'
data = np.genfromtxt(myFile, skip_header=2, skip_footer = 1)

MyFile is a variable name for the .txt file to be read. As long as the .txt file and the script file are in
the same directory, the script file can run automatically by double-clicking the script file after the
correct file has been hard-coded.

The genfromtxt() function allows for the text file to be converted into a numerical matrix.

The skip_header setting allows for the first 2 rows of data to be excluded from the matrix. As
shown in the following figure, the first row of data is ASCII art created by the PuTTY program, and
the second row of data are the column labels — neither of which are numerical data.

Sample Python Code
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7 Data Logging

The skip_footer setting is needed because, when the .txt file is read in real time, the entire last row
of data may not be complete. This causes problems for creating the matrix and needs to be
excluded. This means that the last half-second of data is not displayed when the data are viewed
in real time.

Exclude the first
two rows of data

Sample of Transient Data

# Time (minutes)
x=data[:,2]
x = x/1000/60

Data File Column Descriptions on page 7 - 3 identifies the columns of data recorded. The
fourth column of data contains time in milliseconds, however, the first index in Python is 0;
therefore, 
data[:,3] captures all of the rows (:) in the fourth column.

plt.plot(x,y,'ko')
plt.ylabel('Pressure (Torr)')
plt.xlabel('time (minutes)')
plt.show()

The above code shows the syntax for plotting. The label 'ko' indicates filled black circles.
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